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Betting

At the outset of each hand, you place a bet in the white rectangle in the center of your screen.    There are 
five ways in which you may place or retrieve your bet:

        1)Drag the appropriate number of chips to or from the betting area using your mouse.
        2)Double click on the chip denomination you wish to bet or retrieve.
        3)Click on the appropriate bet amount in the Commands window.
        4)Click on the arrows at the upper right corner of the bet box.
        5)Type the bet amount into the amount area above your bet box.

After a hand wins or pushes (including split hands), chips won or retained can only be returned to your 
credit stacks.    Clicking on Deal in the Commands window, or betting additional chips will cause all chips 
left on the table to center in the bet box for the next hand.

Note: clicking lower into a chip stack will allow you to drag multiple chips to or from the bet box. 

Periodically you will see a symbol in the bet amount area.    The cards will not be dealt when one of these 
symbols are present.    These represent the following:

        - your current bet is under the minimum bet amount.
        + your current bet is over the maximum bet allowed.
        > your current bet exceeds your current credit.



The Game

Every player and the dealer are initially dealt two cards each.    Each player's hand is played against the 
dealer's hand only.    If you obtain a hand value closer to twenty-one (without going over) than the dealer, 
you will win your hand.

You might conclude that the object of the game is to obtain a hand value as close to twenty-one as 
possible without going over.    However, this is NOT true for the expert.    His objective is simply to Beat 
The Dealer!



Card Values

Cards 2 - 10 a numerical value equal to the number printed on the card.

Face cards Jack, Queen and King have the value of ten.

Aces Aces may be counted as either eleven or one.

Hint:
Value of the Ace



Hint:    Value of the Ace

The value of the ace seems to confuse some players under the "heat of the action".    Always count the 
ace as eleven until a count of eleven will put your hand over twenty-one, then count the ace as one.    
Thinking of the ace in these terms will make adding your total card value easier.



A Blackjack

Blackjack - a hand with the value of twenty-one in the first two cards.    This hand contains an ace and a 
ten valued card.    A blackjack is the most powerful hand in the game of blackjack.

When you receive a blackjack, the dealer will pay you three chips for every two that you have bet unless 
the dealer also has a blackjack.    When both you and the dealer have blackjacks, your bet is simply 
retained by you.



Play Options

Hit Take another card.

Stand Stop taking cards.

Split An option available on a two card hand in which each card has equal value (a ten and a 
queen are cards of equal value).    When you split your hand, an amount equal to your 
original wager will be anted and your hand split.    You play two separate hands.    Some 
casinos enforce restrictions on splitting a pair of aces or restrictions on doubling down on 
split hands.

Double Down The double down option is only allowed on a two card hand.    When doubling down, an 
amount equal to your original wager will be wagered, doubling your bet.    You are dealt 
one additional card.    Your hand is played using the three cards.    Some casinos enforce 
double down restrictions.

Surrender The surrender option is allowed on two card hands only.    You give up half of your wager 
and surrender all chances of winning the hand.

Insurance The insurance option is simply another form of wager that is offered to the players when 
the dealer has an ace showing.    Those who take the insurance wager are betting that 
the dealer has a blackjack.    The insurance bet costs one-half your original wager, and 
the payoff, should the dealer indeed have a blackjack, is two-to-one.



Terminology

Push a hand value identical to dealer's, the bet is neither won nor lost, 
Bust a hand value over twenty-one, a losing hand
Hole Card dealer's down card
Shoe a plastic box that sits on the table from which the cards are dealt
Cut the Deck insertion of a plastic card into a shuffled deck to determine the re-shuffle point
Burn after a cut, dealer places 1 to 5 cards into the discard box before the deal
First Base first position dealt, on dealer's immediate left
Third Base last position dealt, on dealer's immediate right
Eye in the Sky overhead electronic surveillance in the casinos

___________
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Hard and Soft Hands

When you have an ace in your hand that counts as eleven, you have what is known as a "soft hand".    If 
you hold no aces or have an ace in your hand that counts as one, you have a "hard hand". 

Hint:
Remembering Hard and Soft Hands



Hint:    Remembering Hard and Soft Hands

Think of an ace in your hand as flexible or "soft" because the hand value can always be reduced.    
Whenever you have a soft hand, you hold a distinct advantage over the dealer.    This is because you can 
never bust when you hit a soft hand.



Signaling Hit or Stand

To signal a hit, hold the left mouse button down and drag the mouse toward you.    To signal an intention 
to stand, hold the left mouse button down and push the mouse away from you.    In either case, releasing 
the left mouse button completes the intended signal.

If you decide to change your mind before you release the left mouse button, you may do so.    Continue 
holding the left mouse button down and drag the mouse in the opposite direction of the signal just 
indicated.    When the hand cursor returns to its original form you may safely release the left mouse button 
or perform any other legal action.

The alternative to hand signals is to select hit or stand in either the commands window or the commands 
menu.



Signaling Split or Double Down

To signal a split or double down, click on the chip stacks immediately in front of you.    The appropriate 
amount of chips will automatically be selected.    When you have two cards of equal value, releasing the 
chips to the left or right of the bet box will signal the intention to split.    Releasing the chips in the bet box 
will signal an intention to double down.    Returning the chips you are holding to your chip stacks, before 
releasing the left mouse button, will allow you to reconsider.

The alternative to hand signals is to select split, or double down in either the commands window or the 
commands menu.



Signaling Surrender

To signal an intention to surrender you must either click on surrender in the commands window or the 
commands menu.    There is no hand signal to signal surrender.



Signaling Insurance

To take insurance, click on the chip stacks immediately in front of you.    Enough chips to cover the 
insurance bet will automatically be selected.    Drag the insurance bet to the insurance semi-circle above 
the bet box and release the left mouse button.

To decline insurance, hold the left mouse button down and push the mouse away from you.    Releasing 
the left mouse button completes the intended signal.
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Menu Commands

The menu bar is the standard Windows interface to all of the Masque Blackjack features.    Click the 
mouse on the action you wish to access or depress the Alt key in conjunction with the underlined letter of 
the action.

Game        Commands        View        Strategy Tables        Strategy Deviations        Training 
Help

Game Game rules, and environment settings
Commands Blackjack game commands
View Controls screen display options
Strategy Tables Allow viewing of the expert strategy tables
Strategy Deviations Allow viewing of the strategy errors you have made
Training Access to additional tutorial features of the game
CD Player Play any of your favorite music CDs in your computer CD-ROM player
Help Provides access to Help topics, and information about this version of Masque 

Blackjack

Related Topis:
Card Counting Drills Strategy Drills
Your Play Results Expert Play Simulation



Game Menu

Rules Clicking on Rules in the Game menu will bring up a dialog box which will allow you to 
select the strategy you wish to master, set the house rules and game parameters.

Environment The Environment selection displays a dialog box which allows you to customize your 
game playing environment.    These include program timing, message displays, error 
warnings, sounds and right mouse button functionality.

Save Settings Clicking on Save Settings will save all programmable options such as strategy 
selections, rules, game parameters and environment choices.    These will become the 
default settings for this and any subsequent sessions of Masque Blackjack.

About Blackjack This option gives you program information about Masque Blackjack for Windows.

Exit Blackjack Exits from Masque Blackjack.    You will be presented with a dialog box asking you 
whether you want to save the current settings.    Selecting YES will save the current 
settings as the default, NO will leave the default settings as they were when last set 
and choosing CANCEL will allow you to continue playing Masque Blackjack.



Commands Menu

The blackjack playing decisions may be selected through the Commands Menu, however, these are more 
readily accessed through the Commands Window, a movable, re-sizable window on your playing table 
(see also View Menu, Commands option).

Each of the options in the Commands Menu may be accessed via the keyboard accelerator key noted to 
the right of each command.



View Menu

The View Menu has a number of settings which are represented by a check mark,    When checked an 
item is visible on the viewing screen.    Those items not represented by a check mark have multiple 
settings which are presented in a sub-menu.

Commands Allows you to make the blackjack playing commands visible in a moveable, re-sizable 
window on your playing screen.

Player Credit The player credit window is a moveable window which shows the credit you have 
remaining.

Recommendation The moveable Recommendation window shows the expert play recommendation for 
your situation.

Hand Value Hand value is the total value of the hand showing.    It is located to the left of the hand 
it represents.

Card Count A sub-menu will appear, allowing you to choose your desired setting, Full, Decks Left 
or Off.    The Full card count window shows the current true count as well as the card 
count history since the last shuffle.    Decks Left shows only the number of decks 
remaining. to be dealt.    The accelerator key, ^C, will allow you to toggle from one 
display to the other.

Odds The odds window is moveable and capable of presenting three types of odds 
calculations, Your Next Card, General Dealer, Dealer Holds, and Off.    These 
calculations are the probabilities for your next card draw, what the dealer will end up 
with when he starts out with his present up card and what the dealer's current two 
card hand value is.    The accelerator key, ^O, will allow you to toggle from one 
display to the other.



Strategy Tables

The Strategy Tables menu choices allow you to view any of the expert strategy tables.    Each of these 
selections has an accelerator key selection, to the right of each command, allowing direct keyboard 
access from your playing screen.    Any selection displays the corresponding expert strategy table.

Draw and Stand Surrender
Double Down Insurance
Split Bet

Recommended Choosing Recommended will instruct the computer to select the appropriate 
strategy table for your viewing.

Note:    The draw / stand and double down strategy tables have both a hard hand and a soft hand strategy 
table.    When you are between playing hands, (before the cards are dealt for a new hand), both tables will 
appear.    When you are faced with a strategy decision, only the appropriate table, depending on whether 
your hand is hard or soft, will appear.

Related Topics:
Strategy Deviations Hard Hands / Soft Hands



Strategy Deviations

When you do not follow the expert play recommendation, it is classified as a strategy deviation.    Your 
strategy deviations are recorded for your review.    Click on this selection to view the deviations you have 
made.

The Strategy Deviations menu choices allow you to view all the instances where you did not follow the 
expert strategy recommendation.    The strategy deviation tables are very similar to the corresponding 
expert strategy tables.    The difference is, instead of a completed expert strategy table, the only tiles 
marked are those for which your play during this session deviated from the expert strategy of play.    Any 
blank tile grids indicate that you either played the given situation correctly each time or that the situation 
did not present itself during this session.

You have two options for recording your deviations.    To modify your options, refer to the Games Menu - 
Environment selection.    One option is to mark only the table that you should have followed.    The second 
allows marking both the table you should have followed and the table that you did follow.

An example of two tables being marked:    the correct strategy for a hand of 8,8 vs a dealer 8 is to split.    If 
you select draw, both the split and hard hand draw tables will be marked as a strategy deviation.    
However, if you had chosen to double down, only the split table will be marked.    The double down hard 
hand table has no grid which accommodates such a situation.

Related Topics:
Strategy Tables
Hard Hands / Soft Hands



CD Player

You may play any of your favorite music CDs in your computer's CD-ROM drive while you enjoy your 
game.    If a CD-ROM drive is present on your system, you will be able to select the CD Player... 
menu item.

Once selected, you may place the CD Player dialog box anywhere on your screen by dragging the 
CD Player Title Bar to the desired screen location.    Clicking on the System-Menu box, in the upper 
left corner of the CD Player dialog, allows you to move, close or alter the dialog box appearance. 

        Status shows the current CD track, the total number of CD tracks and the elapsed time 
into the current track. 

        Buttons makes the CD play, stop, previous track, next track and eject control buttons 
visible. 

        No Title shrinks the dialog box by eliminating the Title Bar.    Double-clicking on a blank 
area of the dialog box will cause the Title Bar to re-appear.

        Small Buttons shrinks the dialog box by making the control buttons smaller.



Help

The Help Menu includes the following selections:

Be a Winner Gives you tips on a systematic approach to quickly becoming an expert player.

Strategy Origins Credits the author of the Masque Blackjack strategies, Julian Braun.

Index Selecting this option will give you an index of all available categories for which you 
may obtain help.

Menu Commands Selecting the Commands option will give you a listing of available Masque Blackjack 
commands.

Keyboard Gives you help with the keyboard commands.

how to play The How to Play option will offer help on how to play.

Using Help Explains how to use the Windows help system.



Be A Winner

Mastering blackjack involves acquiring a winning blackjack strategy, learning it and following its advice 
religiously.    Your learning process will prove most beneficial to you if you learn the strategy in the order of 
your greatest theoretical advantage.    That play strategy order is:

1)    Draw/Stand Strategy
2)    Hard Double Down Strategy
3)    Split Strategy
4)    Soft Double Down Strategy
5)    Surrender Strategy

Augment this with a simple method of counting cards.    Once card counting is mastered, take full 
advantage of the winning strategy potential by implementing the:

6)    Bet Strategy
7)    Insurance Strategy 
8)    Point Count Strategy"

The order of strategy decision making is constant for all situations.    Always consult the strategy decision 
charts in the following order: 

1)    Surrender Strategy
2)    Split Strategy
3)    Double Down Strategy
4)    Draw/Stand Strategy"

"Masque has even gone a step further than Thorp and Braun in their    statistical analyses of the game.    
Their manual is one of the best books ever written on the game of blackjack!",        Carlos Perez, a noted 
Vegas gambler, author and free-lance writer.

The manual that accompanies this software explains the strategies, helpful card counting tips, an 
explanation of the game and statistical analysis, the set of common blackjack rules most favorable to the 
player, common rule variation advantages and disadvantages and numerous suggestions to further 
improve your game and winnings.

Sure it's fun to play, but take the time to read the manual.    The more fully you understand your blackjack 
strategy and its reasoning, the easier it will be for you to master it!



Strategy Origins

All strategies and dealer probability calculations were formulated by Julian H. Braun, M.S., Formerly of 
IBM Corporation, Julian is widely recognized as one of the world's foremost experts on blackjack 
probability and strategy analysis.    He has been quoted in numerous articles and his accomplishments 
have often been cited by many other blackjack strategy authors.    His research of over    18    years has 
culminated in the development of the    world's most powerful, easy to use blackjack strategies available. 
His works, presented to you in computerized form, provide you with the proof, the means and power to 
master blackjack in a most effective, efficient manner.



Card Counting Drills

Card Counting gives the advanced blackjack player an increasing edge against the dealer in the form of 
altering the basic game playing strategy, the betting strategy and the insurance strategy in agreement 
with the ever changing deck composition.    The card counting drills feature has two menus Practice and 
Options which include the following choices:

Begin Card Counting Start the card counting session.

Abort this round There will be times when you need to suddenly interrupt your practice session, 
perhaps when your option settings are not to your liking.    This selection does not 
exit the card counting feature, it simply ends the current round of card counting.    
This option can only be selected when a card counting practice session is in 
progress.

Quit Card Counting To exit the card counting feature, click on this option.

Exit Blackjack Select Exit Blackjack to leave the Masque Blackjack game.    You will be 
presented with a dialog box asking you whether you want to save the current 
settings.    Selecting YES will save the current settings as the default, NO will 
leave the default settings as they were when last set and choosing CANCEL will 
allow you to continue playing Masque Blackjack.

Options presents you with a dialog box which allows you to set the card count window 
display, the number of decks to practice with, the time interval between cards 
dealt and the number of player hands that are being dealt.    A full card count 
display window is automatically visible after all decks have been dealt, allowing a 
full review of the card counting round.



Strategy Drills

The Strategy Drills Menu Bar gives you an overview of the of the strategy practice features of Masque 
Blackjack.    This feature is important to your blackjack playing skill development.    To gain a positive edge 
against the house you need to know the finer aspects of winning blackjack strategies.

Under regular play, a number of "tricky" situations may never occur.    Under strategy practice, the 102 
blackjack hands most likely to trip you up in real play will each be given once in a random order.    Some 
of these situations may seem simple at first, but when a surrender rule is allowed they become one of 
those tricky situations.    If you do not score consistently high on the strategy practice feature of this game, 
don't bet too much in the casinos!

The Strategy Practice Menu Bar includes the following menus:

Game Game rules, and environment settings
Commands Blackjack game commands
View Controls screen display options
Strategy Tables Allow viewing of the expert strategy tables
Strategy Deviations Allow viewing of the strategy errors you have made



Practice

Practice Options Practice Options presents you with a dialog box that allows you to turn the hand 
value display On/Off and set the type of warnings you will get when you deviate 
from the expert strategy of play.

Rules Allows you to determine which of the four strategies you wish to be drilled on and 
set the house rules that will affect you strategy of play.    The only rule settings that 
affect correct strategy of play are the double down restrictions, the form of 
surrendering allowed and whether doubling down is permitted after splitting.

Quit Practice To exit the strategy practice drill feature, click on this option.

Exit Blackjack Select Exit Blackjack to leave the Masque Blackjack game.    You will be presented 
with a dialog box asking you whether you want to save the current settings.    
Selecting YES will save the current settings as the default, NO will leave the 
default settings as they were when last set and choosing CANCEL will allow you 
to continue playing Masque Blackjack.



Commands

The blackjack playing decisions may be selected through the Commands Menu, however, these are more 
readily accessed through the Commands Window, a movable, re-sizable window on your playing table 
(see also View Menu, Commands option).

Each of the options in the Commands Menu may be accessed via the keyboard accelerator key noted to 
the right of each command.



View

The View Menu has settings which are represented by a check mark,    When checked an item is visible 
on the viewing screen.    Those items not represented by a check mark have multiple settings which are 
presented in a sub-menu.

Commands Allows you to make the blackjack playing commands visible in a moveable, re-sizable 
window on your playing screen.

Recommendation The moveable Recommendation window shows the expert play recommendation for 
your situation.

Hand Value Hand value is the total value of the hand showing.    It is located to the left of the hand 
it represents.



Strategy Tables

The Strategy Tables menu choices allow you to view any of the expert strategy tables.    Each of these 
selections has an accelerator key selection, to the right of each command, allowing direct keyboard 
access from your playing screen.    Any selection displays the corresponding expert strategy table.

Draw and Stand Surrender
Double Down Insurance
Split Bet

Recommended Choosing Recommended will instruct the computer to select the appropriate 
strategy table for your viewing.

Note:    The draw / stand and double down strategy tables have both a hard hand and a soft hand strategy 
table.    When you are between playing hands, (before the cards are dealt for a new hand), both tables will 
appear.    When you are faced with a strategy decision, only the appropriate table, depending on whether 
your hand is hard or soft, will appear.



Strategy Deviations

When you do not follow the expert play recommendation, it is classified as a strategy deviation.    Your 
strategy deviations are recorded for your review.    Click on this selection to view the deviations you have 
made.

The Strategy Deviations menu choices allow you to view all the instances where you did not follow the 
expert strategy recommendation.    The strategy deviation tables are very similar to the corresponding 
expert strategy tables.    The difference is, instead of a completed expert strategy table, the only tiles 
marked are those for which your play during this session deviated from the expert strategy of play.    Any 
blank tile grids indicate that you either played the given situation correctly each time or that the situation 
did not present itself during this session.

You have two options for recording your deviations.    To modify your options, refer to the Practice Menu - 
Environment selection.    One option is to mark only the table that you should have followed.    The second 
allows marking both the table you should have followed and the table that you did follow.

An example of two tables being marked:    the correct strategy for a hand of 8,8 vs a dealer 8 is to split.    If 
you select draw, both the split and hard hand draw tables will be marked as a strategy deviation.    
However, if you had chosen to double down, only the split table will be marked.    The double down hard 
hand table has no grid which accommodates such a situation.



Your Play Results

Your Play Results allows you to view a statistical compilation of how well you are doing.



Expert Play Simulation

The Expert Play Simulation allows you to select the strategy, the table rules and parameters, then have 
the computer quickly simulate expert strategy play.    The ensuing statistical results will allow you to test 
and analyze any of the Masque Blackjack strategies.    This gives you a unique and thorough opportunity 
to see the strengths of the blackjack strategies presented in the Masque Blackjack game.    An entire 
chapter of your manual, The Expert Play Simulation Analysis explains the meaning of and importance 
each of its statistics.

Begin Simulation Start the computer simulation of expert strategy play.

Options Simulation options allow you to determine the number of hands played between 
statistic updates, the interval between cards and the maximum number of hands to 
play in the simulation run.

Rules Allows you to determine which of the four strategies you wish to test, the house 
rules and game parameters.

Stop Simulation To halt the expert play simulation, click on stop simulation.

Quit Practice To exit the expert play simulation feature, click on this option.

Exit Blackjack Select Exit Blackjack to leave the Masque Blackjack game.    You will be presented 
with a dialog box asking you whether you want to save the current settings.    
Selecting YES will save the current settings as the default, NO will leave the default 
settings as they were when last set and choosing CANCEL will allow you to 
continue playing Masque Blackjack.



Expert Play Simulation View

Each of the View Menu options are On/Off selections denoted by a check mark.    The items checked are 
visible on the viewing screen.    Those items include:

Cards Allows you to make the simulation cards visible while the simulation is run.    The 
interval between which the cards are displayed is an Option set from the Expert 
Simulation Play menu.

Statistics Shows the simulation statistics as the simulation is run.    The update frequency of 
the statistics is determined by an Option setting in the Expert Simulation Play 
menu.

Hands & Credit When Hands & Credit is selected, the number of simulation hands played and the 
current simulation credit are displayed.



Training

The Training Menu selections allow you to access features of Masque Blackjack which are designed to 
quickly improve various aspects of your playing ability.    These include:

Card Counting Drills Card counting practice drills can improve your card counting ability and 
confidence.    Cards are displayed at user programmable time intervals that can 
challenge any level of ability.

Strategy Drills Playing a round of blackjack does not guarantee that you will be faced with all of 
the difficult decision hands.    Strategy practice drills will give each of 102 
borderline decisions once in a random order and grade your results.    Your 
accuracy is displayed and the strategy errors you make are recorded you your 
review.

Your Play Results This selection allows you to view a statistical evaluation of how well you are 
doing.

Expert Play Simulation The Expert Play Simulation allows you to select the strategy, set the table playing 
conditions and have the computer quickly play a user programmable number of 
hands like an expert.    The ensuing results are tabulated statistically, showing 
you the value of and true strengths of the expert strategy (see also the chapter 
titled The Expert Play Simulation Analysis in the manual).



Masque Blackjack Keys

Key(s) Function

F1 Gets Help and displays the Help Index for Masque Blackjack. If the Help window is 
already open, pressing F1 displays the "Using Windows Help" topics.

Accelerator Keys Function

Ctrl+T Display the Draw / Stand strategy tables.

Ctrl+D Display the Double Down strategy tables.

Ctrl+S Display the Split strategy table.

Ctrl+U Display the Surrender strategy table.

Ctrl+I Display the Insurance strategy table.

Ctrl+B Display the Betting strategy table.

Ctrl+R Display the Recommended strategy table.


